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Important Safety Instructions

Setting up the Printer 

Choosing a Place for the Printer 

Using the Printer 

Handling Ink Cartridges 

Warnings, Cautions, and Notes 

Read all of the instructions in this section before using the printer. Also, be sure to follow all warnings and 
instructions marked on the printer.

Setting up the Printer

Observe the following when setting up the printer:

Do not block or cover the vents and openings in the printer.
Use only the type of power source indicated on the printer’s label.
Use only the power cord that comes with the printer. Use of another cord may result in fire or 
electric shock.
The printer’s power cord is for use with the printer only. Use with other equipment may result in fire 
or electric shock.
Be sure your AC power cord meets the relevant local safety standard.
Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch 
on and off.
Avoid electrical outlets controlled by wall switches or automatic timers.
Keep the entire computer system away from potential sources of electromagnetic interference, such 
as loudspeakers or the base units of cordless telephones.
Do not use a damaged or frayed power cord.
If you use an extension cord with the printer, make sure that the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure that the 
total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s 
ampere rating.
Do not attempt to service the printer yourself.
Unplug the printer and refer servicing to qualified service personnel under the following conditions: 
The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or 
the casing damaged; the printer does not operate normally or exhibits a distinct change in 
performance.
When connecting the printer to a computer or other device with a cable, ensure the correct 
orientation of the connectors. Each connector has only one correct orientation. Inserting a connector 
in the wrong orientation may damage both devices connected by the cable.
If damage occurs to the plug, replace the cord set or consult a qualified electrician. 
If there are fuses in the plug, make sure you replace them with fuses of the correct size and rating.

Top  

Choosing a Place for the Printer



Observe the following when choosing a place for the printer:

Place the printer on a flat, stable surface that extends beyond the base of the printer in all 
directions. If you place the printer by the wall, leave more than 10 cm between the back of the 
printer and the wall. The printer will not operate properly if it is tilted at an angle.
When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down. 
Otherwise, ink may leak from the cartridges.
Leave enough space in front of the printer for the paper to be fully ejected.
Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from 
direct sunlight, strong light, or heat sources.
Avoid places subject to dust, shocks, or vibrations.
Leave enough room around the printer to allow for sufficient ventilation.
Place the printer near a wall outlet where the plug can be easily unplugged.
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Using the Printer

Observe the following when using the printer:

Do not insert objects through the slots in the printer.
Take care not to spill liquid on the printer.
Do not put your hand inside the printer or touch the ink cartridges during printing.
Do not touch the white flat cable inside the printer.
Do not use aerosol products that contain flammable gases inside or around this printer. Doing so 
may cause fire.
Do not move the print head by hand; otherwise, you may damage the printer.

Always turn the printer off using the  power button. When this button is pressed, the  power 

light flashes. Do not unplug the printer or turn off the power to the outlet until the  power light 
stops flashing.
Before transporting the printer, make sure that the print head is in the home (far right) position and 
the ink cartridges are in place.
Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may 
prevent the printer from printing.
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Handling Ink Cartridges

Observe the following when handling the ink cartridges:

Keep ink cartridges out of the reach of children. Do not allow children to drink from or handle the 
cartridges.
Shake new ink cartridges four or five times before opening their packages.
Do not shake ink cartridges after opening their packages; this can cause leakage.
Be careful when you handle used ink cartridges, as there may be some ink remaining around the ink 
supply port. If ink gets on your skin, wash the area thoroughly with soap and water. If ink gets into 
your eyes, flush them immediately with water. If discomfort or vision problems remain after a 
thorough flushing, see a doctor immediately.
Do not remove or tear the label on the cartridge; this can cause leakage.
Install the ink cartridge immediately after you remove it from its package. If you leave a cartridge 
unpacked for a long time before using it, normal printing may not be possible.
Use the ink cartridge before the date printed on its package.
Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.



After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.
Store ink cartridges in a cool, dark place.
Do not touch the green IC chip on the side of the cartridge. Doing so may prevent normal operation 
and printing.
If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust, and store 
it in the same environment as the printer. A valve in the ink supply port makes covers or plugs 
unnecessary, but the ink may stain items that come into contact with this area of the cartridge. Do 
not touch the ink supply port or the surrounding area.
Store ink cartridges with their labels facing upward. Do not store cartridges upside down.
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Warnings, Cautions, and Notes

Warnings, Cautions, and Notes in this User’s Guide are indicated as below and have the following meaning.

Warnings

must be followed carefully to avoid bodily injury.

Cautions

must be observed to avoid damage to your equipment.

Notes

contain important information and useful tips on the operation of the printer.
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Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or 
by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written 
permission of Seiko Epson Corporation. The information contained herein is designed only for use with this 
Epson printer. Epson is not responsible for any use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of 
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this 
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and 
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original Epson Products or Epson 
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference 
that occurs from the use of any interface cables other than those designated as Epson Approved Products 
by Seiko Epson Corporation.

Epson® and Epson Stylus® are registered trademarks, and Epson Exceed Your Vision is a registered 
logomark of Seiko Epson Corporation.

PRINT Image Matching™ and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation. 
Copyright © 2001 Seiko Epson Corporation. All rights reserved.

Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

Apple® and Macintosh® are registered trademarks of Apple Inc.

Intel® is a registered trademark of Intel Corporation.

PowerPC® is a registered trademark of International Business Machines Corporation.

General Notice: Other product names used herein are for identification purposes only and may be 
trademarks of their respective owners. Epson disclaims any and all rights in those marks. 

Copyright © 2009 Seiko Epson Corporation. All rights reserved.
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Operating System Versions

In this manual, the following abbreviations are used.

Windows refers to Windows Vista, XP, and 2000. 

Windows Vista refers to Windows Vista Home Basic Edition, Windows Vista Home Premium Edition, 
Windows Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista Ultimate 
Edition.
Windows XP refers to Windows XP Home Edition, Windows XP Professional x64 Edition, and 
Windows XP Professional.
Windows 2000 refers to Windows 2000 Professional.

Macintosh refers to Mac OS X. 

Mac OS X refers to Mac OS X 10.3.9, 10.4.x - 10.5.x.
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User’s Guide Help

Finding your way around

This User’s Guide includes links to make moving between sections easier. Links appear as colored, 
underlined text. When you place your cursor over a link, it changes to a hand icon. Click the link to access a 
related topic or detailed information.

You can also click these links to move around the User’s Guide:

 Home
Returns to the opening page.

 Contents
Opens the Table of Contents.

You can close the window by clicking the  Close button.

 Index
Opens the Index.

You can close the window by clicking the  Close button.

 Search
Opens the Search window, where you can locate topics by entering keywords.

 Top Returns to the top of the current page.

Printing a Topic

To print the page you are currently on, open the File menu and click Print in your browser.

Solving Display Problems

If a page in the User’s Guide displays incorrectly, click the Refresh or Reload button in your browser.
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Printer Driver and Status Monitor

Accessing the Printer Driver for Windows 

Accessing the Printer Driver for Mac OS X 

The printer driver lets you choose from a wide variety of settings to get the best printing results. Status Monitor 
and the printer utilities help you check the printer and keep it in top operating condition.

Note for Windows users:

Your printer driver automatically finds and installs the latest version of the printer driver from 
Epson’s web site. Click the Driver Update button in your printer driver’s Maintenance tab, 
and then follow the on-screen instructions. If the button does not appear in the 
Maintenance tab, point to All Programs or Programs in the Windows Start menu, and 
check in the Epson folder.
If you want to change the language of the driver to Spanish or Portuguese, select the 
language you want to use from the Language setting in your printer driver’s Maintenance 
tab.

Accessing the Printer Driver for Windows

You can access the printer driver from most Windows applications, the Windows Start menu, or the taskbar.

To make settings that apply only to the application you are using, access the printer driver from that application.

To make settings that apply to all of your Windows applications, access the printer driver from the Start menu 
or the taskbar.

Refer to the following sections to access the printer driver.

Note:

Screen shots of the printer driver windows in this User’s Guide are from Windows Vista.

From Windows applications

Click Print or Print Setup on the File menu.

In the window that appears, click Printer, Setup, Options, Preferences, or Properties. (Depending on 
your application, you may need to click one or a combination of these buttons.) 

From the Start menu

Windows Vista: 



Click the  button, select Control Panel, and then select Printer from the Hardware and Sound category. 
Then select the printer and then select Printing Preferences.

Windows XP:

Click Start, Control Panel, Printers and Other Hardware, then Printers and Faxes. Select the printer, 
then click Printing Preferences in the File menu. 

Windows 2000:

Click Start, point to Settings, then click Printers. Select the printer, then click Printing Preferences in the 
File menu. 

From the shortcut icon on the taskbar

Right-click the printer icon on the taskbar, then select Printer Settings.

To add a shortcut icon to the Windows taskbar, first access the printer driver from the Start menu as described 
above. Next, click the Maintenance tab, the Speed & Progress button, and then the Monitoring 
Preferences button. In the Monitoring Preferences window, select the Select Shortcut Icon check box.

Getting information through online help

You can access online help for items in the printer driver from your application or the Windows Start menu.

Accessing the Printer Driver for Windows 

In the printer driver window, try one of the following procedures.

Right-click the item, then click Help.

Click the  button at the top right of the window, then click the item (for Windows XP and 2000 only).
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Accessing the Printer Driver for Mac OS X

The table below describes how to access the printer driver dialog boxes.

Dialog Box How to Access It

Page Setup Click Page Setup on the File menu of your application.

Note for Mac OS X 10.5.x:

Depending on your application, the Page Setup menu may not 
appear in the File menu.

Print Click Print in the File menu of your application.



EPSON Printer 
Utility3

You can access this software in the following three ways:
Double-click the EPSON Printer Utility3 icon in the Applications folder 
in Macintosh HD. Select the printer from the Printer List, then click OK.
Click Print from your application’s File menu, choose Print Settings in 

the Print window that is displayed, then click the  Utility icon. This 
Utility icon is not displayed when the printer is shared.
For Mac OS X 10.3.9 - 10.4.x only 
Open the Applications folder on your hard drive, then open the Utilities 
folder and double-click the Print Center or Printer Setup Utility icon. 
Select the appropriate printer from the list, then click the Configure or 
Utility button.
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Printing Photos the Easy Way

Starting Epson Easy Photo Print 

Epson Easy Photo Print lets you lay out and print digital images on various types of paper. The step-by-step 
instructions in the window let you preview the printed images and get the effects you want without having to 
make any difficult settings.

Using the Quick Print function, you can perform one-click printing with the settings you make.

Starting Epson Easy Photo Print

Double-click the Epson Easy Photo Print icon on the desktop.
For Windows Vista:  

Click the  button, point to All Programs, click Epson Software, and then click Easy Photo 
Print. 
 
For Windows XP and 2000:  
Click Start, point to All Programs (Windows XP) or Programs (Windows 2000), point to Epson 
Software, then click Easy Photo Print.

For more information, select User’s Guide from the Help menu in this application.
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Printing Web Pages to Fit to Your Paper Size

Accessing EPSON Web-To-Page 

EPSON Web-To-Page lets you make web pages fit to your paper size when printing. You can also see a preview before 
printing.

Note:

●     

This software is not available for Windows Vista, XP x64 or Mac OS X.

●     

This software is compatible only with Internet Explorer 5.x to 6.x.

Note for Windows Internet Explorer 7 users:

Printing web pages to fit to your paper size is a standard feature in Windows Internet Explorer 7.

Accessing EPSON Web-To-Page

After you install EPSON Web-To-Page, the menu bar is displayed on the Microsoft Internet Explorer Toolbar. If it does 
not appear, select Toolbars from the View menu of Internet Explorer, and then select EPSON Web-To-Page.
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Uninstalling the Printer Software

Uninstalling the Printer Driver 

Uninstalling the User’s Guide 

Uninstalling Other Epson Applications 

Uninstalling the Printer Driver

You may need to uninstall your printer driver if you:

Upgrade your computer’s operating system.
Update your printer driver with a newer version except when updating through your printer driver’s update 
function; the function uninstalls the older version automatically.
Have a problem with the printer driver.

If you are upgrading your operating system or updating the printer driver version, be sure to uninstall the current 
printer driver before upgrading or installing the new driver. Otherwise, the driver update will not work.

For Windows users 

Note:

●     

To uninstall programs in Windows Vista, you need an administrator account and the password if you 
log on as a standard user.

●     

To uninstall programs in Windows XP, you must log on to a Computer Administrator account. 

●     

To uninstall programs in Windows 2000, you must log on as a user with administrative privileges 
(belonging to the Administrators group).

Turn off the printer and disconnect the USB cable.



Windows Vista:  

Click the  button and select Control Panel.  
 
Windows XP:  
Click Start, then select Control Panel. 
 
Windows 2000:  
Click Start, point to Settings, and select Control Panel. 

Windows Vista:  
Click Uninstall a program from the Programs category, and then select EPSON Stylus T21 Series Printer 
Uninstall from the list. 
 
Windows XP and 2000: 
Double-click the Add or Remove Programs icon and select EPSON Stylus T21 Series Printer Uninstall 
from the list. 

Windows Vista:  
Click Uninstall/Change, then click Continue in the User Account Control window. 
 
Windows XP and 2000:  
Click Change/Remove.

Select the icon for your printer and click OK.

Click OK to uninstall the printer driver.

For Mac OS X

Note:

To uninstall the programs, you must log on to a Computer Administrator account. You cannot 
uninstall programs if you log on as a Limited account user. 
Depending on the application, the Installer may be separated from the Uninstaller.

Quit all running applications.

Insert the Epson printer software CD-ROM into your Macintosh.

Double-click the Epson icon in the CD window.

Note:

If the Authenticate dialog box appears, enter your password or phrase and click OK.



Select English at the language selection screen.

The Custom Installation screen appears. Deselect all items except Epson Stylus T21 Driver, then click 
Install.

Note:

If the Authenticate dialog box appears, enter your password or phrase and click OK.

At the Installer screen, select Uninstall in the pop-up menu, then Uninstall.

Follow the on-screen instructions to uninstall the printer driver.

Click Quit to close the installation program.

Note for Mac OS X 10.3.9 to 10.4.x:

If the name of your printer remains in the Print Center or Printer Setup Utility, select the name from 
Printer List and click Delete.
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Uninstalling the Epson User’s Guide

For Windows users

Note:

●     

To uninstall programs in Windows Vista, you need an administrator account and the password if you 
log on as a standard user.

●     

To uninstall applications in Windows XP, you must log on to a Computer Administrator account. You 
cannot uninstall applications if you log on as a Limited user. 

●     

To uninstall applications in Windows 2000, you must log on as a user with administrative privileges 
(belonging to the Administrators group). 

Turn off the printer and disconnect its USB cable.



Windows Vista:  

Click the  button and select Control Panel.  
 
Windows XP:  
Click Start, then select Control Panel. 
 
Windows 2000:  
Click Start, point to Settings, and select Control Panel. Click the start button and select Control Panel.

Windows Vista:  
Click Uninstall a program from the Programs category, then select Epson Stylus T21 Series User's Guide 
from the list.  
 
Windows XP and 2000:  
Double-click the Add or Remove Programs icon and select Epson Stylus T21 Series User's Guide from 
the list.

Windows Vista:  
Click Uninstall/Change, then click Continue in the User Account Control window.  
 
Windows XP and 2000:  
Click Change/Remove.

Click OK.

For Mac OS X

Note:

To uninstall the programs, you must log on to a Computer Administrator account. You cannot 
uninstall programs if you log on as a Limited account user.

Quit all running applications.

Open the Applications folder, then open the Epson folder.

Drag the guide folder to the Trash.
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Uninstalling Other Epson Applications

You can uninstall applications you do not need. Follow the steps below.

For Windows users

Note:



●     

To uninstall programs in Windows Vista, you need an administrator account and the password 
if you log on as a standard user.

●     

To uninstall applications in Windows XP, you must log on to a Computer Administrator 
account. You cannot uninstall applications if you log on as a Limited user. 

●     

To uninstall applications in Windows 2000, you must log on as a user with administrative 
privileges (belonging to the Administrators group). 

Windows Vista:  

Click the  button and select Control Panel.  
 
Windows XP:  
Click Start, then select Control Panel. 
 
Windows 2000:  
Click Start, point to Settings, and select Control Panel. Click the start button and select Control Panel.

Windows Vista:  
Click the Uninstall a program from the Programs category. 
 
Windows XP and 2000:  
Double-click the Add or Remove Programs icon.

Choose the software you want to uninstall from the list of programs.

Windows Vista:  
Click the Uninstall/Change, then click Continue in the User Account Control window.  
 
Windows XP and 2000:  
Click Change/Remove.

When the confirmation message appears, click Yes.

Follow the on-screen instructions.

For Mac OS X

Note:



To uninstall applications, you must log on to a Computer Administrator account. You cannot 
uninstall applications if you log on as a Limited account user.
Depending on the application, the Installer may be separated from the Uninstaller.

 

Quit all running applications.

Insert the Epson printer software CD-ROM into your Mac.

Double-click the Epson icon in the CD window.

Note:

If the Authenticate dialog box appears, enter your password or phrase and click OK.

Select English at the language selection screen.

The Custom Installation screen appears. Deselect all items except Epson Easy Photo Print, then click Install.

Note:

If the Authenticate dialog box appears, enter your password or phrase and click OK.

At the Installer screen, select Uninstall in the pop-up menu, then click Uninstall.

Follow the on-screen instructions to uninstall the application.

Click Quit to close the installation program.

Note:

If you cannot select Uninstall in step 6, double-click the Applications folder in your Mac OS X hard 
drive, select the application you want to uninstall, and then drag it to the Trash icon.
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Using Special Paper 

Loading Capacities for Epson Special Media 

Storing Epson Photo Paper 

You can achieve good results with most types of plain bond paper. However, coated papers provide superior printouts 
because they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet printers, and recommends these 
papers to ensure high-quality results.

Paper 

When loading special paper distributed by Epson, read the instruction sheets packed with the paper first and keep the 
following points in mind.

Note:

Load the paper into the sheet feeder printable side up. The printable side is usually whiter or 
glossier. See the instruction sheets packed with the paper for more information. Some types of 
paper have cut corners to help identify the correct loading direction.
If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing 
on curled paper may cause ink to smear on your printout.

Loading Capacities for Epson Special Media

Refer to the table below for the loading capacities of Epson special paper and other media.

Media Type Loading Capacity

Epson High Quality Ink Jet Plain Paper Up to 80 sheets

Epson Bright White Paper Up to 60 sheets

Epson Photo Paper Glossy Up to 20 sheets

Epson Premium Photo Paper Glossy Up to 10 sheets for 5 × 7 in. (13 × 18 cm) and 16:9 
wide size (102 × 181 mm)
Up to 20 sheets for all other sizes



Epson Premium Photo Paper Semi-gloss Up to 20 sheets

Epson Ultra Premium Photo Paper Glossy Up to 20 sheets 

Epson Premium Presentation Paper Matte 1 sheet

Note:

The availability of paper varies by location.

Top  

Storing Epson Photo Paper

Return unused paper to the original package as soon as you finish printing. Epson recommends storing your printouts 
in a resealable plastic bag. Keep them away from high temperature, humidity, and direct sunlight.
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Loading Paper

Follow these steps to load paper:

Slide the edge guide to the left.

Fan a stack of paper, then tap it on a flat surface to even the edges.

Load the paper with the printable side up, against the right side of the sheet feeder. The printable side is often 
whiter or brighter than the other side.

Slide the edge guide against the left edge of the paper, but not too tightly.



Note:

●     

Leave enough space in front of the printer for the paper to be fully ejected.

●     

Always load paper into the sheet feeder short edge first, even when you are printing 
landscape-oriented pictures.

●     

Make sure the paper stack fits under the  arrow mark inside the edge guide.
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Loading Envelopes

Follow these steps to load envelopes:

Slide the edge guide to the left.

Load envelopes short edge first with the flap facing down and to the left. Then slide the edge guide against the left 
edge of the envelopes, but not too tightly.

Note:



●     

The thickness of envelopes and their ability to fold vary widely. If the total thickness of the 
stack of envelopes exceeds 10 mm, press down on the envelopes to flatten them before 
loading. If print quality declines when a stack of envelopes is loaded, load one envelope at a 
time.

●     

You can load up to 10 envelopes at a time in the sheet feeder.

●     

Do not use envelopes that are curled or folded.

●     

Press each envelope flat before loading it or load one envelope at a time.

●     

Avoid using envelopes that are too thin, as they may curl during printing.

For printing instructions, see the following instructions.

Printing on Envelopes 
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Selecting the Correct Paper Type

The printer automatically adjusts itself for the type of paper you select in your print settings. That is why the 
paper type setting is so important. It tells your printer what kind of paper you are using and adjusts the ink 
coverage accordingly. The table below lists the settings you should choose for your paper.

For this paper Select this paper type setting

Plain paper*, Single sheets Plain paper / Bright White Paper

Epson Bright White Paper*

Epson Ultra Premium Photo Paper Glossy* Ultra Premium Photo Paper Glossy

Epson Premium Photo Paper Glossy* Premium Photo Paper Glossy

Epson Photo Paper Glossy* Photo Paper Glossy

Epson Premium Photo Paper Semi-gloss* Premium Photo Paper Semi-gloss

Epson Premium Presentation Paper Matte* Premium Presentation Paper Matte

Envelopes Envelope

* These paper types are compatible with Exif Print and PRINT Image Matching. For more information, 
refer to the documentation that came with the Exif Print or PRINT Image Matching compatible digital 
camera.

Note:

The availability of special media varies by location. For the latest information on media available 
in your area, contact Epson customer support. 

 See Contacting Technical Support
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Introduction

Printing Photos 

Printing Documents 

Printing Web Pages 

Printing on Envelopes 

This section guides you through the procedures for different kinds of printing.

Printing photos

Explains how to print photos on various types of paper. 

 See Printing Photos 
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Printing Documents

Explains how to print documents on various types of paper. 

 See Printing Documents 
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Printing Web Pages

Explains how to print Web pages so that they fit on a sheet of paper without getting cut off on the right side. 



 See Printing Web Pages 
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Printing on Envelopes

Explains how to print on envelopes. 

 See Printing on Envelopes 
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Printing Photos

Preparing to Print the File 

Paper Compatible with Borderless Printing 

Loading Paper 

Printing from Epson Easy Photo Print 

Printing from Other Applications 

Preparing to Print the File

When you print a borderless photo, part of the image will be cropped off because this option enlarges the image slightly 
beyond the paper size.

You need to adjust the image file to the size of the paper. If your application has margin settings, make sure they are 
set to zero before printing.
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Paper Compatible with Borderless Printing

If you want to print borderless photos, refer to the table below because borderless printing is not available for all types 
of paper.

Epson Photo Paper Glossy A4 (210 × 297 mm [8.3 × 11.7 in.]), Letter (8,5 × 11 in. 
[21.59 × 27.94 cm]), 4 × 6 in. (10 × 15 cm)

Epson Ultra Premium Photo Paper Glossy Letter (8,5 × 11 in. [21.59 × 27.94 cm]), 4 × 6 in. 
(10 × 15 cm), 5 × 7 in. (13 × 18 cm)

Epson Premium Presentation Paper Matte Letter (8,5 × 11 in. [21.59 × 27.94 cm])

Epson Premium Photo Paper Glossy Letter (8,5 × 11 in. [21.59 × 27.94 cm]), 4 × 6 in. 
(10 × 15 cm), 5 × 7 in. (13 × 18 cm), 16:9 wide size 
(102 × 181 mm)

Epson Premium Photo Paper Semi-gloss Letter (8,5 × 11 in. [21.59 × 27.94 cm]), 4 × 6 in. 
(10 × 15 cm)

Note:



Borderless printing takes longer than normal printing.
Print quality may decline in the top and bottom areas of the printout, or the area may be smeared 
when printing on papers other than those listed above. Print a single sheet to check the quality 
before printing large jobs.
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Loading Paper

Refer to the section below for details on loading paper.

Loading Paper 

When using special Epson paper, refer to the section below.

Using Special Paper 
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Printing from Epson Easy Photo Print

Using Epson Easy Photo Print included on the CD-ROM is the easiest and quickest way to create various photos, such as 
borderless photos or photos with borders or frames. Epson Easy Photo Print also helps you enhance your photos.

Starting Epson Easy Photo Print

Refer to the following section for details on starting Epson Easy Photo Print.

Starting Epson Easy Photo Print 
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Printing from Other Applications

Printer settings for Windows

Follow these steps to adjust your printer settings.

Access the printer settings.

Accessing the Printer Driver for Windows 



Click the Main tab, then select one of the following Quality Option 
settings: 

Photo for good quality and speed
Best Photo for the best print quality

Select the appropriate Type setting.

Selecting the Correct Paper Type 

Select Borderless if you want to print borderless photos.

If you want to control the amount of the image that extends beyond the edges of the paper, click the Page Layout 
tab, select Auto Expand as the Enlargement Method, and then adjust the Expansion slider.

Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an entire job.



Printer settings for Mac OS X 10.5.x

Follow these steps to adjust your printer settings.

Access the Print dialog box.

Accessing the Printer Driver for Mac OS X 

Click the  button to extend this dialog box.

Select the printer you are using as the Printer setting, and then make suitable settings.



Note:

Depending on your application, you may not be able to select some of the items in this dialog 
box. If so, click Page Setup on the File menu of your application, and then make suitable 
settings.
Select XXX (Borderless) as the Paper Size if you want to print borderless photos.

Select Print Settings from the pop-up menu.



Make the settings that you want to use to print. See online help for details of Print Settings.

Selecting the Correct Paper Type 

After completing the steps above, print one test copy and examine the results before printing an entire job.

Note:

You can control the amount of the image that extends beyond the edges of the paper during borderless 
printing. See online help for details.

Printer settings for Mac OS X 10.3.9 to 10.4.x

Follow these steps to adjust your printer settings.

Access the Page Setup dialog box.

Accessing the Printer Driver for Mac OS X 

Select the printer you are using as the Format for setting.

Select the appropriate Paper Size setting.

Note:

Select XXX (Borderless) if you want to print borderless photos.

Select the appropriate Orientation settings.



Click OK to close the Page Setup dialog box.

Access the Print dialog box.

Accessing the Printer Driver for Mac OS X 

Select the printer you are using as the Printer setting. Then make the Copies & Pages settings.

Select Print Settings from the pop-up menu.



Select the appropriate Media Type, Color, and Mode settings. See online help for details of Print Settings.

Selecting the Correct Paper Type 

After completing the steps above, print one test copy and examine the results before printing an entire job.

Note:

You can control the amount of the image that extends beyond the edges of the paper during borderless 
printing. See online help for details.
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Printing Documents

Loading Paper 

Printer Settings for Windows 

Printer Settings for Mac OS X 10.5.x 

Printer Settings for Mac OS X 10.3.9 to 10.4.x 

Loading Paper

Refer to the section below for details on loading paper.

Loading Paper 

When using special Epson paper, refer to the section below.

Using Special Paper 
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Printer Settings for Windows

Open the file you want to print.

Access the printer settings.

Accessing the Printer Driver for Windows 



Click the Main tab, then select one of the following Quality Option 
settings: 

Draft for rough drafts with reduced print quality
Text for text-only documents with higher text quality
Text & Image for higher quality documents with text and images

Select the appropriate Type setting.

Selecting the Correct Paper Type 

Select the appropriate Size setting. You can also define a custom paper size. For details, see the online help.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click OK to close the printer settings window.

Print your file.
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Printer Settings for Mac OS X 10.5.x

Follow these steps to adjust your printer settings.

Open the file you want to print.

Access the Print dialog box.

Accessing the Printer Driver for Mac OS X 

Click the  button to extend this dialog box.

Select the printer you are using as the Printer setting, and then make suitable settings.



Note:

Depending on your application, you may not be able to select some of the items in this dialog box. If so, 
click Page Setup on the File menu of your application, and then make suitable settings.

Select Print Settings from the pop-up menu.



Make the settings that you want to use to print. See online help for details of Print Settings.

Selecting the Correct Paper Type 

Click Print to start printing.
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Printer Settings for Mac OS X 10.3.9 to 10.4.x

Open the file you want to print.

Access the Page Setup dialog box.

Accessing the Printer Driver for Mac OS X 

Select the printer you are using as the Format for setting.

Select the appropriate Paper Size and Orientation settings. You can also define a custom paper size. For details, see 
the online help.

Click OK to close the Page Setup dialog box.

Access the Print dialog box.

Accessing the Printer Driver for Mac OS X 



Select the printer you are using as the Printer setting. Then make the Copies & Pages settings.

Select Print Settings from the pop-up menu.



Select the appropriate Media Type, Color, and Mode settings. See online help for details of Print Settings.

Selecting the Correct Paper Type 

Click Print to start printing.
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Printing Web Pages

Loading Paper 

Using EPSON Web-To-Page 

Loading Paper

Refer to the section below for details on loading paper.

Loading Paper 

When using special Epson paper, refer to the section below.

Using Special Paper 
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Using EPSON Web-To-Page

The EPSON Web-To-Page software lets you print Web pages so that they fit within the width of your selected paper.

Note for Windows users:

●     

This software is not available for Windows Vista or Windows XP x64.

●     

Printing web pages to fit to your paper size is a standard feature in Windows Internet Explorer 
7.

Note for Mac OS X users:



●     

This software is not available for Mac OS X.

●     

Macintosh users can print Web pages using the printer driver. 

 See Printer settings for Mac OS X 10.3.9 to 10.4.x 

In Internet Explorer, go to the Web page you want to print.

If you have installed EPSON Web-To-Page, the EPSON Web-To-Page toolbar appears on the Internet Explorer 
window.

Click the Print button on the toolbar. The Print window appears.

Note:

If you want to preview the layout of your printout, click the Print Preview button on the toolbar.

Right-click the printer icon and choose Printing Preferences.



Click the Main tab, then select one of the following Quality Option 
settings: 

Draft for rough drafts with reduced print quality
Text for text-only pages with higher text quality
Text & Image for higher quality pages with text and images

Select the appropriate Type setting.

Selecting the Correct Paper Type 

Select the appropriate Size setting. You can also define a custom paper size. For details, see the online help.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click OK to close the printer settings window.

Print your page.
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Printing on Envelopes

Loading Envelopes 

Printer Settings for Windows 

Printer Settings for Mac OS X 10.5.x 

Printer Settings for Mac OS X 10.3.9 to 10.4.x 

Loading Envelopes

Refer to the section below for loading envelopes.

Loading Envelopes 

Refer to the section below for the printable area.

Printable Area 
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Printer Settings for Windows

Access the printer settings.

Accessing the Printer Driver for Windows 



Click the Main tab, then select one of the following Quality Option 
settings: 

Text for most envelopes
Text & Image to print images on the envelope

Select Envelope as the Type setting.

Select the appropriate envelope size from the available Size settings. You can also define a custom size. For details, 
see the online help.

Select Landscape as the Orientation setting.

Click OK to close the printer settings window.

Print your envelope.
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Printer Settings for Mac OS X 10.5.x

Follow these steps to adjust your printer settings.

Access the Print dialog box.

Accessing the Printer Driver for Mac OS X 

Click the  button to extend this dialog box.

Select the printer you are using as the Printer setting, and then select a suitable envelope size as the Paper Size 
setting. You can also define a custom envelope size. For details, see the online help.

Select Landscape as the Orientation setting.



Note:

Depending on your application, you may not be able to select some of the items in this dialog box. If so, 
click Page Setup on the File menu of your application, and then make suitable settings.

Select Print Settings from the pop-up menu.

Make the settings that you want to use to print. See online help for details of Print Settings.



Click Print to start printing.
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Printer Settings for Mac OS X 10.3.9 to 10.4.x

Access the Page Setup dialog box.

Accessing the Printer Driver for Mac OS X 

Select the printer you are using as the Format for setting.

Select the appropriate envelope size as the Paper Size setting. You can also define a custom envelope size. For 
details, see the online help.

Select Landscape as the Orientation setting.

Click OK to close the Page Setup dialog box.

Access the Print dialog box.

Accessing the Printer Driver for Mac OS X 



Select the printer you are using as the Printer setting, then make the Copies & Pages settings.

Select Print Settings from the pop-up menu.



Select Envelope as the Media Type setting, then select the appropriate Color and Mode settings. See online help 
for details on Print Settings.

Click Print to start printing.
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Canceling Printing

Using the Printer Button 

For Windows 

For Mac OS X 

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the Printer Button

Press the  maintenance button to cancel a print job in progress.
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For Windows

Note:

You cannot cancel a print job that has been sent to the printer. In this case, cancel the print job by the 
printer.

Using the progress meter

When you start printing, the progress meter appears on your computer screen.

Click the Stop button to cancel printing.



Using the Windows Spooler for Vista

Click the  button, select Control Panel, and then select Printer from the Hardware and Sound 
category. 

Right click on the printer and then select Open.

Right click on the job you want to cancel and then select Cancel.

Using the Windows Spooler for XP

Click Start, Control Panel, Printers and Other Hardware, and then click Printers and Faxes.

Right click on the printer and then select Open.

Right click on the job you want to cancel and then select Cancel.

Using the Windows Spooler for 2000

Click Start, point to Settings, and then click Printers.

Right click on the printer and then select Open.

Right click on the job you want to cancel and then select Cancel.
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For Mac OS X

Follow the steps below to cancel a print job.

Click your printer icon in the Dock.

In the Document Name list, select the document which is printing.

Click the Delete button to cancel the print job.
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Introduction 

2-sided Printing (Windows Only) 

Fit to Page Printing 

Pages Per Sheet Printing 

Poster Printing (Windows Only) 

Watermark Printing (Windows Only) 

You can print with a variety of layouts for special projects, such as booklets and posters.

2-sided Printing (Windows Only)

Lets you print on both sides of the paper.  

 See 2-sided Printing (Windows Only) 
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Fit to Page Printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in the printer driver. 

 See Fit to Page Printing 

Note for Mac OS X users:

This is a standard feature of Mac OS X 10.4 and later. This feature is not available for Mac OS X 10.3.9.
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Pages Per Sheet Printing

Lets you print two or four pages on a single sheet of paper. 

 See Pages Per Sheet Printing 
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Poster Printing (Windows Only)

Lets you enlarge material on a single document page to cover 4, 9, or 16 printed sheets of paper, and then make a 
poster. 

 See Poster Printing (Windows only) 

Note:

This feature is not available for Mac OS X.
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Watermark Printing (Windows Only)

Lets you print text or an image as a watermark on each page of your printout. 

 See Watermark Printing (Windows Only) 

For example, you can put “Confidential” on an important document.

Note:

This feature is not available for Mac OS X.
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2-sided Printing (Windows Only)

Standard 2-sided Printing 

Folded Booklet 2-sided Printing 

Two types of 2-sided printing are available: standard and folded booklet.

Standard 2-sided printing allows you to print the odd-numbered pages first. Once these pages are printed, you can 
reload them to print the even-numbered pages onto the opposite side of the paper.

Folded booklet 2-sided printing allows you to make single-fold booklets. The pages that will appear on the outside (after 
the page is folded) are printed first. The pages that will appear inside the booklet can then be printed after you reload 
the paper into the printer as shown in the illustration below.

Single-fold booklet

* : Binding edge

You can create a booklet by printing pages 1 and 4 on the first sheet of paper, pages 5 and 8 on the second sheet, and 
pages 9 and 12 on the third sheet.



After you reload these sheets into the sheet feeder, you can then print pages 2 and 3 on the back of the first sheet of 
paper, pages 6 and 7 on the back of the second sheet, and pages 10 and 11 on the back of the third sheet.

The resulting pages can then be folded and bound together into a booklet.

Note:

●     

This feature is not available for Mac OS X.

●     

This feature is not available with borderless printing.

●     

This feature is not available when the printer is accessed over a network or is used as a 
shared printer.

●     

Depending on the paper, stacks of up to 30 sheets can be loaded into the sheet feeder during 
2-sided printing.

●     

Only use papers that are suitable for 2-sided printing. Otherwise, the printout quality may 
deteriorate.

●     

Depending on the paper and the amount of ink used to print text and images, ink may bleed 
through to the other side of the paper.

●     

The surface of the paper may be smeared during 2-sided printing.

Standard 2-sided Printing

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet.

Access the printer settings.

Accessing the Printer Driver for Windows 



Click the Main tab, then select one of the following Quality Option settings:

Draft for rough drafts with reduced print quality
Text for text-only pages
Text & Image for higher quality pages with text and images
Photo for good quality and speed
Best Photo for the best print quality

Select the appropriate Type setting.

Selecting the Correct Paper Type 

Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click the Page Layout tab, then select On from 2-sided printing.



Click Margins to open the Margins window.



Specify the edge of the paper where the binding will be placed. You can choose Left, Top, or Right.

Choose cm or inch as the Unit setting. Then specify the width of the binding margin. You can enter any width from 
0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches.

Note:

The actual binding margin may be different from the specified settings depending on your application. 
Experiment with a few sheets to examine actual results before printing the entire job.

Click OK to return to the Page Layout window. Then click OK to save your settings.

Load paper into the sheet feeder, then send the print job from your application. Instructions for generating the 
even-numbered pages will be displayed while the odd-numbered pages are printed.

Loading Paper 

Follow the on-screen instructions to reload the paper.

Note:

●     

The paper may curl during printing due to the amount of ink used. Should this occur, slightly 
curl the sheets in the opposite direction before reloading them.

●     

Align the sheet stack by tapping its edges against a hard, flat surface before reloading the 
stack.

●     

Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or 
the binding margins may be incorrect.

●     

If a paper jam occurs, refer to the following. 

 See The Paper Jams 

Once the paper is reloaded, click Resume to print the even-numbered pages.
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Folded Booklet 2-sided Printing

Use the following steps to create a folded booklet.

Access the printer settings.

Accessing the Printer Driver for Windows 



Click the Main tab, then select one of the following Quality Option settings:

Draft for rough drafts with reduced print quality
Text for text-only pages
Text & Image for higher quality pages with text and images
Photo for good quality and speed
Best Photo for the best print quality

Select the appropriate Type setting.

Selecting the Correct Paper Type 

Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click the Page Layout tab and select On from 2-sided printing. Then click the Folded Booklet check box.



Click Margins to open the Margins window.



Specify the edge of the paper where the binding will be placed. You can choose Left, Top, or Right.

Note:

When you select Portrait as the Orientation setting, the Left or Right binding positions are available. 
The Top binding position is available when you select Landscape as the Orientation setting.

Choose cm or inch as the Unit setting. Specify the width of the binding margin.

Portrait Landscape

* : Folding edge
** : Margin

You can enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches. The specified margin width will 
be used on both sides of the fold. For example, if you specify a 1 cm margin, you will get a 2 cm margin (a margin 
of 1 cm will be placed on each side of the fold).

Click OK to return to the Page Layout window. Then click OK to save your settings.

Load paper into the sheet feeder, then send the print job from your application. Instructions for printing the inside 
pages will be displayed while the outside pages are printed.

Loading Paper 

Follow the on-screen instructions to reload the paper.

Note:

●     

The paper may curl during printing due to the amount of ink used. Should this occur, slightly 
curl the sheets in the opposite direction before reloading them.

●     

Align the sheet stack by tapping its edges against a hard, flat surface before reloading it in the 
printer.

●     

Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or 
the binding margins may be incorrect.

●     

If a paper jam occurs, refer to the following. 



 See The Paper Jams 

Once the paper is reloaded, click Resume to print the inside pages.

Once printing is complete, fold the sheets and bind them together using a stapler or other binding method.
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Fit to Page Printing

Printer Settings for Windows 

Printer Settings for Mac OS X 10.5.x 

You can use the Fit to Page printing function when you want to print, for example, an A4 size document on another size 
paper.

Fit to Page printing automatically resizes your page to the paper size you select. You can also resize your page manually.

Note:

This feature is not available with borderless printing.

Note for Mac OS X users:

This is a standard feature of Mac OS X 10.4.x or later. To use this feature, make sure to select a 
standard paper size (for example, A4) as the Paper Size setting and the Scale to fit paper size setting. 
Do not select a paper size with a page setup option (for example, Borderless). This feature is not 
available for Mac OS X 10.3.9.

Printer Settings for Windows

Access the printer settings.

Accessing the Printer Driver for Windows 



Click the Main tab, then select one of the following Quality Option settings:

Draft for rough drafts with reduced print quality
Text for text-only pages
Text & Image for higher quality pages with text and images
Photo for good quality and speed
Best Photo for the best print quality

Select the appropriate Type setting.

Selecting the Correct Paper Type 

Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click the Page Layout tab, then select the Reduce/Enlarge Document check box.



Do one of the following:

If you selected By Output Paper Size, select the size of the paper you are using from the drop-down list.
If you selected By Percentage, use the arrows to choose a percentage.

Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an entire job.
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Printer Settings for Mac OS X 10.5.x

Access the Print dialog box.

Accessing the Printer Driver for Mac OS X 



Click the  button to extend this dialog box.

Select the printer you are using as the Printer setting, and then make suitable settings.

Note:

Depending on your application, you may not be able to select some of the items in this dialog box. If so, 
click Page Setup on the File menu of your application, and then make suitable settings.

Select Paper Handling from the pop-up menu.



Select the Scale to fit paper size.

Make sure that the appropriate size is displayed in Destination Paper Size.

Select Print Settings from the pop-up menu.



Make the settings that you want to use to print. See online help for details of Print Settings.

Selecting the Correct Paper Type 

After completing the steps above, print one test copy and examine the results before printing an entire job.
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Pages Per Sheet Printing

Printer Settings for Windows 

Printer Settings for Mac OS X 10.5.x 

Printer Settings for Mac OS X 10.3.9 to 10.4.x 

Pages Per Sheet printing allows you to print two or four pages on single sheets of paper.

Note:

This feature is not available with borderless printing.

Printer Settings for Windows

Access the printer settings.

Accessing the Printer Driver for Windows 



Click the Main tab, then select one of the following Quality Option settings:

Draft for rough drafts with reduced print quality
Text for text-only pages
Text & Image for higher quality pages with text and images
Photo for good quality and speed
Best Photo for the best print quality

Select the appropriate Type setting.

Selecting the Correct Paper Type 

Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click the Page Layout tab, select Multi-Page, then select Pages per Sheet.



Select from the following settings for Pages Per Sheet printing:

2, 4 Prints two or four pages of your document on a single piece of paper.

Print Page 
Borders

Prints frames around the pages printed on each sheet.

Page Order Allows you to specify the order in which the pages will be printed on the sheet of 
paper. Some settings may be unavailable, depending on the Orientation setting 
on the Main window.

Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an entire job.
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Printer Settings for Mac OS X 10.5.x



Access the Print dialog box.

Accessing the Printer Driver for Mac OS X 

Click the  button to extend this dialog box.

Select the printer you are using as the Printer setting, and then make suitable settings.

Note:

Depending on your application, you may not be able to select some of the items in this dialog box. If so, 
click Page Setup on the File menu of your application, and then make suitable settings.



Select Layout from the pop-up menu.

Select from the following settings:

Pages per Sheet Prints multiple pages of your document on a single piece of paper.
You can choose from 1, 2, 4, 6, 9, or 16. 

Layout Direction Allows you to specify the order in which the pages will be printed on the sheet of 
paper. 

Border Prints a border around the pages printed on each sheet. You can choose from 
None, Single Hairline, Single Thin Line, Double Hairline, or Double Thin 
Line.

Select Print Settings from the pop-up menu.



Make the settings that you want to use to print. See online help for details of Print Settings.

Selecting the Correct Paper Type 

After completing the steps above, print one test copy and examine the results before printing an entire job.
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Printer Settings for Mac OS X 10.3.9 to 10.4.x



Access the Page Setup dialog box.

Accessing the Printer Driver for Mac OS X 

Select the printer you are using as the Format for setting.

Select the appropriate Paper Size and Orientation settings.

Click OK to close the Page Setup dialog box.

Access the Print dialog box.

Accessing the printer driver for Mac OS X 



Select the printer you are using as the Printer setting, then make the Copies & Pages settings.

Select Layout from the pop-up menu.

Select from the following settings:

Pages per Sheet Prints multiple pages of your document on a single piece of paper. You can 
choose from 1, 2, 4, 6, 9, or 16.

Layout Direction Allows you to specify the order in which the pages will be printed on the sheet of 
paper.

Border Prints a border around the pages printed on each sheet. You can choose from 
None, Single Hairline, Single Thin Line, Double Hairline, or Double Thin 
Line.

Select Print Settings from the pop-up menu.



Select the appropriate Media Type, Color, and Mode settings. See the online help for details of Print Settings.

Selecting the Correct Paper Type 

After completing the steps above, print one test copy and examine the results before printing an entire job.
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Poster Printing (Windows Only)

Printer Settings 

How to Make a Poster from Your Printouts 

Poster printing allows you to print poster-size images by enlarging one page to cover several sheets of paper.

Note:

This feature is not available for Mac OS X.

Printer Settings

Access the printer settings.

Accessing the Printer Driver for Windows 



Click the Main tab, then select one of the following Quality Option 
settings: 

Draft for rough drafts with reduced print quality
Text for text-only documents
Text & Image for higher quality pages with text and images
Photo for good quality and speed
Best Photo for the best print quality

Select the appropriate Type setting.

Selecting the Correct Paper Type 

Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click the Page Layout tab and select Multi-Page, then select Poster Printing. Click the up or down arrow to 
select 2x1, 2x2, 3x3, or 4x4.



Select Borders or Borderless according to the following table.

Borders Prints panels with margins to be cut and overlapped.

Borderless Allows you to make posters without cutting the margins and overlapping 
the panels.

If you want to control the amount of the image that extends beyond the edges of the paper, click the Page Layout 
tab, select Auto Expand as the Enlargement Method, and then adjust the Expansion slider.

Click Settings to adjust the way your poster will be printed. The Poster Settings window opens.



Make the following settings:

Print Cutting 
Guides

Prints guide lines for cutting.

Overlapping 
Alignment 
Marks

Slightly overlaps the panels and prints alignment markers so that the panels can 
be aligned more precisely.

Trim Lines Prints border lines on the panels to guide you when trimming the pages.

Note:

●     

If you select Borderless in step 7, the message "The poster prints will be borderless." 
appears on the window and the settings in the table above are not available.

●     

If you want to print only a few of the panels without printing the entire poster, click the panels 
that you do not want to print.

Click OK to close the Poster Settings window.

After completing the steps above, print one test copy and examine the results before printing an entire job. Then follow 
the instructions.

How to make a poster from your printouts 
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How to Make a Poster from Your Printouts

Here is an example of how to make a poster with 2x2 selected under Poster Printing and Overlapping Alignment 
Marks selected as the Print Cutting Guides.

Cut off the margin of Sheet 1 along a vertical line through the center of the top and bottom cross 
marks: 

Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets 
together from the back:

Cut the taped sheets in two along a vertical line through the alignment markers (this time, a line to the left of the 
cross marks):

Align the edges of the paper using the alignment markers and tape them together from the back:



Repeat the instructions from step 1 to step 4 to tape Sheets 3 and 4 together.

Repeat the instructions from step 1 to step 4 to tape the top and bottom edges of the paper:

Cut off the remaining margins.
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Watermark Printing (For Windows Only)

Printing the Watermark 

Creating Your Own Watermark 

Watermark printing allows you to print a text-based or image-based watermark on your document.

Note:

This feature is not available for Mac OS X.
This feature is not available with borderless printing.

Printing the Watermark

Access the printer settings.

Accessing the Printer Driver for Windows 



Click the Main tab, then select one of the following Quality Option 
settings: 

Draft for rough drafts with reduced print quality
Text for text-only documents with higher text quality
Text & Image for higher quality documents with text and images

Select the appropriate Type setting.

Selecting the Correct Paper Type 

Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click the Page Layout tab, choose the desired watermark from the Watermark list, then click Settings.



If you want to create your own watermark, see the following instructions.

Creating your own watermark 

Specify the settings you want for the watermark. You can change the position and size of the watermark by 
dragging the image within the preview window.



Click OK to return to the Page Layout window.

Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an entire job.
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Creating Your Own Watermark

You can add your own text-based or image-based watermarks to the Watermark list.

Click Add/Del under Watermark on the Page Layout window. The following window appears.



Do one of the following:

To use an image file as a watermark, select BMP. Click Browse to locate the bitmap file you want to use, 
then click OK. Type a name for your watermark in the Name text box, then click Save.
To create a text-based watermark, select Text. Type your text in the Text box. This text will also be used as 
the watermark name. If you want to change the watermark name, type a new name in the Name text box, 
then click Save.

Click OK to return to the Page Layout window.

Click Settings. The following window 
appears: 



Make sure that the appropriate watermark is selected in the Watermark list, then select Color, Position, Density, 
Size, Font, Style, and Angle settings. (For details, see the online help.) Your settings are reflected in the preview 
window.

When you finish making settings, click OK.
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Checking the Ink Cartridge Status

For Windows 

For Mac OS X 

For Windows

Note:

●     

Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink 
cartridges are installed, the ink cartridge status may not be displayed.

●     

When an ink cartridge is running low, the Low Ink Reminder screen automatically appears. 
You can also check the ink cartridge status from this screen. If you do not want to display this 
screen, first access the printer driver and then click the Maintenance tab, Speed & 
Progress, and then Monitoring Preferences. On the Monitoring Preferences screen, clear 
the Enable Low Ink Reminder check box.

To check the ink cartridge status, do one of the following:

Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the 
following section: 

 See From the Shortcut Icon on the Taskbar 

Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button. A graphic 
displays the ink cartridge status.



Note:

If any of the ink cartridges installed in the printer is broken, incompatible with the printer model, or 
improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of the ink 
cartridge status. Be sure to replace or reinstall any ink cartridge indicated by EPSON Status Monitor 3.

The progress meter appears automatically when you start a print job. You can check the ink cartridge status 
from this window. Click the Check Ink Levels button on the progress meter screen to display the ink cartridge 
status as shown below.
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For Mac OS X

Note for Mac OS X 10.5.x

When an ink cartridge is running low, the Low Ink Reminder window automatically appears. You can also 
check the ink cartridge status from this window. If you do not want to display this window, select the 
Preferences menu from the Application menu when the Low Ink Reminder window is displayed, and 
then clear the Enable Low Ink Reminder check box.

You can check the ink cartridge status using EPSON StatusMonitor. Follow the steps below.

Access the EPSON Printer Utility3 dialog box.

Accessing the Printer Driver for Mac OS X 

Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.



Note:

●     

The graphic displays the ink cartridge status when EPSON StatusMonitor was first opened. To 
update the ink cartridge status, click Update.

●     

Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink 
cartridges are installed, the ink cartridge status may not be displayed.

●     

If any of the ink cartridges installed in the printer is broken, incompatible with the printer 
model, or improperly installed, EPSON StatusMonitor will not display an accurate status of the 
ink cartridge. Be sure to replace or reinstall any ink cartridge indicated by the EPSON 
StatusMonitor.

Note for Mac OS X 10.5.x

The printer monitor window appears automatically when you start a print job. You can check the ink 
cartridge status from this window.
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Precautions on Ink Cartridge Replacement

Read all of the instructions in this section before replacing the ink cartridges.

●     

This printer uses ink cartridges equipped with an IC chip that monitors the amount of ink used by 
each cartridge. Cartridges are usable even if they are removed and reinserted.

●     

Some ink is consumed from all cartridges during the following operations: print head cleaning and 
ink charging when an ink cartridge is installed.

●     

If you need to remove an ink cartridge temporarily, be sure to protect the ink supply area from 
dirt and dust. Store the ink cartridge in the same environment as the printer. When storing the 
cartridge, be sure that its label identifying the color of the ink cartridge is facing upward. Do not 
store ink cartridges upside down.

●     

The valve in the ink supply port is designed to contain any excess ink that may be released. 
However, careful handling is recommended. Do not touch the supply port of the ink cartridge or its 
surrounding area.

●     

For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. Ink 
cartridges with low ink status may not be used when reinserted.

●     

Other products not manufactured by Epson may cause damage that is not covered by Epson’s 
warranties, and under certain circumstances, may cause erratic printer behavior.

●     

Keep ink cartridges out of the reach of children. Do not allow children to drink from or handle the 
cartridges.

●     

Be careful when you handle used ink cartridges, as there may be some ink around the ink supply 
port. If ink gets on your skin, wash the area thoroughly with soap and water. If ink gets into your 
eyes, flush them immediately with water. If discomfort or vision problems continue after a 
thorough flushing, see a doctor immediately.

●     

Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality 
or reliability of non-genuine ink. The use of non-genuine ink may cause damage that is not 
covered by Epson’s warranties, and under certain circumstances, may cause erratic printer 
behavior. Information about non-genuine ink levels may not be displayed, and use of non-genuine 
ink is recorded for possible use in service support.

●     

Do not open the ink cartridge package until you are ready to install it in the printer. The cartridge 
is vacuum packed to maintain its reliability.

●     

Leave the old cartridge installed in the printer until you have obtained a replacement; otherwise, 
ink remaining in the print head nozzles may dry out.

●     



You cannot continue printing with one ink cartridge expended, even if the other cartridges still 
contain ink. Before printing, replace the expended cartridge.
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Conserving Black Ink When the Cartridge Is Low (Windows Only)

The window below appears when black ink runs low and there is more color ink than black ink. It appears only when 
Plain paper / Bright White Paper is selected as the paper type, and Text is selected as the Quality Option.

The window gives you the option to either continue using black ink normally or conserve black ink by using a mixture of 
color inks to create black.

Click the Yes button to use a mixture of color inks to create black. You will see the same window the next time 
you print a similar job.
Click the No button to continue using the remaining black ink for the job you are printing. You will see the same 
window the next time you print a similar job, and again have the option to conserve black ink.
Click Disable this feature to continue using the remaining black ink.
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Replacing an Expended Ink Cartridge

Using the Printer Buttons 

Using Your Computer 

You can replace an ink cartridge using the printer buttons or using your computer. Refer to the appropriate section below 
for instructions.

Note:

Do not open the ink cartridge package until you are ready to install it in the printer. The cartridge is 
vacuum packed to maintain its reliability.

Using the Printer Buttons

This table describes the status of the lights and the actions you need to take.

Lights Action

Obtain a replacement ink cartridge.

Replace the expended ink cartridge.

 flashing,  on

Note:

If an ink cartridge is low, you may continue to use it until it is expended. To confirm the status of each 
ink cartridge, see one of the following sections: 

 See Using EPSON Status Monitor 3 (Windows) 

 See Using EPSON StatusMonitor (Mac OS X)

To replace an ink cartridge using the  maintenance button, follow the steps below.

Caution:

Do not remove the cartridge from the printer until you are ready to replace it with another.

Note:



The illustrations show replacement of the cyan ink cartridge, but the instructions are the same for all the 
cartridges.

Make sure the  power light is on, but not flashing.

Open the printer cover.

Press the  maintenance button. The print head moves to the ink cartridge check position and the  power 

light begins to flash. The ink cartridge indicated by the  mark is expended.

Caution:

●     

Do not move the print head by hand, as this may damage the printer. Always press the 
 maintenance button to move it.

●     

Be careful not to touch the white flat cable inside the printer.



Note:

Do not hold the  maintenance button for more than three seconds, or the printer may start cleaning 
the print head.

Press the  maintenance button again.

If more than one ink cartridge is expended, the print head moves to the  mark. This occurs each time you press 
the  maintenance button until all expended ink cartridges have been indicated.

Once all of the expended ink cartridges have been indicated, the print head moves to the ink cartridge replacement 
position when you press the  maintenance button.

For best results, shake the new ink cartridge four or five times before opening the package.

Remove the new ink cartridge from the package.

Caution:



●     

Be careful not to break the hooks on the side of the ink cartridge when you remove it from the 
package.

●     

Do not touch the green IC chip on the side of the cartridge. This can damage the ink cartridge.

●     

Always install an ink cartridge immediately after removing the old cartridge. If the cartridge is 
not installed promptly, the print head may dry out and be unable to print.

Remove the yellow tape from the bottom of the ink cartridge.

Caution:

●     

You must remove the yellow tape from the cartridge before installing it; otherwise, print 
quality may decline or you may not be able to print.

●     

If you have installed an ink cartridge without removing the yellow tape, take the cartridge out 
of the printer, remove the yellow tape, and then reinstall it.

●     

Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge 
may become unusable.

●     



Do not remove or tear the label on the cartridge; otherwise, ink will leak.

Open the cartridge cover.

Caution:

Be careful not to touch the parts highlighted below.



Squeeze the tab at the back of the ink cartridge that you want to replace. Lift the cartridge straight up and out of 
the printer. Dispose of it properly.

Note:

If it is difficult to remove the cartridge, lift the cartridge with more force until it comes out.

Place the ink cartridge into the cartridge holder with the bottom down. Then push down the ink cartridge until it 
clicks into place.

When you are finished replacing cartridges, close the cartridge cover and the printer cover.



Press the  maintenance button.

The printer moves the print head and begins charging the ink delivery system. This process takes about one and a 

half minutes to complete. When ink charging is finished, the print head returns to its home position. The  power 
light stop flashing and remains on, and the  error light goes out.

Caution:

The  power light continues to flash while the printer is charging ink. Never turn off the printer while 
this light is flashing. Doing so can result in incomplete charging of ink.

Note:

If the  error light is flashing or is on after the print head moves to its home position, the ink 
cartridge may not be installed properly. Press the  maintenance button again, press the ink cartridge 
down until it clicks into place, and then close the cartridge cover firmly.
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Using Your Computer

You can monitor the ink cartridge status from your computer and view on-screen instructions for replacing a low or 
expended ink cartridge.

When you need to replace an ink cartridge, click How to in the EPSON Status Monitor window. Follow the on-screen 
instructions to replace the cartridge.

For more information on using your computer to replace ink cartridges, see the section below. 

 See Using EPSON Status Monitor 3 (Windows)  

 See Using EPSON StatusMonitor (Mac OS X)
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Replacing an Ink Cartridge Before It Is Expended

Using Your Computer for Windows 

Using Your Computer for Mac OS X 

You may need to replace an ink cartridge before it is expended if it has been installed in your printer for more than six 
months and print quality declines.

To replace an ink cartridge before the  error light turns on or EPSON Status Monitor notifies you that the cartridge is 
expended, follow the instructions in this section.

Note:

●     

You can only replace an ink cartridge by using the printer buttons when an ink cartridge is 
expended.

●     

Do not open the ink cartridge package until you are ready to install it in the printer. The 
cartridge is vacuum packed to maintain its reliability.

Using Your Computer for Windows

You can view on-screen instructions for replacing an ink cartridge using the printer maintenance utilities.

If you need to replace an ink cartridge before it is low or expended, click the button on the Maintenance tab.



For more information on using the printer utilities, see the online help.
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Using Your Computer for Mac OS X

If you need to replace an ink cartridge before it is low or expended, access the EPSON Printer Utility3 dialog box.

Accessing the printer driver for Mac OS X 
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Checking the Print Head Nozzles

Using the Nozzle Check Utility for Windows 

Using the Nozzle Check Utility for Mac OS X 

Using the Printer Buttons 

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to identify the problem by 
checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility or from the printer by using 
the buttons.

Using the Nozzle Check Utility for Windows

Follow the steps below to use the Nozzle Check utility.

Make sure that no lights are indicating errors.

Make sure that Letter- or A4-size paper is loaded in the sheet feeder.

Right-click the printer icon on the taskbar, then select Nozzle Check.

If the printer icon does not appear, refer to the following section to add the icon.

From the Shortcut Icon on the Taskbar 

Follow the on-screen instructions.
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Using the Nozzle Check Utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

Make sure that no lights are indicating errors.

Make sure that Letter- or A4-size paper is loaded in the sheet feeder.

Access the EPSON Printer Utility3 dialog box.

Accessing the Printer Driver for Mac OS X 

Click the Nozzle Check button in the Utility dialog box.



Follow the on-screen instructions.
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Using the Printer Buttons

Follow the steps below to check the print head nozzles using the printer buttons.

Make sure that no lights are indicating errors.

Turn off the printer.

Make sure that Letter- or A4-size paper is loaded in the sheet feeder.

Hold down the  maintenance button and press the  power button to turn on the printer.

When the printer turns on, release both the buttons. The printer prints the nozzle check pattern.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no print quality problems, 
such as gaps or missing segments in the test lines, the print head is fine.

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink nozzle or a 
misaligned print head.



 See Cleaning the Print Head  

 See Aligning the Print Head 
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Cleaning the Print Head

Using the Head Cleaning Utility for Windows 

Using the Head Cleaning Utility for Mac OS X 

Using the Printer Buttons 

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to solve these problems by 
cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer driver or from the printer 
by using the buttons.

Note:

●     

Because print head cleaning uses ink from all cartridges, clean the print head only if print 
quality declines; for example, if the printout is blurry or the color is incorrect or missing.

●     

Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This 
saves ink.

●     

When ink is low you may not be able to clean the print head. When ink is expended you 
cannot clean the print head. Replace the appropriate ink cartridge first.

Using the Head Cleaning Utility for Windows

Follow the steps below to clean the print head using the Head Cleaning utility.

Make sure the printer is turned on.

Make sure that no lights are indicating errors.

Right-click the printer icon on the taskbar, then select Head 
Cleaning. 

If the printer icon does not appear, refer to the following section to add the icon.

From the shortcut icon on the taskbar 

Follow the on-screen instructions.

The  power light flashes while the printer performs the cleaning cycle.

Caution:



Never turn off the printer while the  power light is flashing. Doing so may damage the printer.

Note:

●     

If print quality has not improved after repeating this procedure about four times, turn the 
printer off and wait for at least six hours. Then run the nozzle check again and repeat the 
head cleaning if necessary. If print quality has still not improved, contact Epson support.

●     

To maintain print quality, we recommend printing a few pages on a regular basis.
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Using the Head Cleaning Utility for Mac OS X

Follow the steps below to clean the print head using the Head Cleaning utility.

Make sure the printer is turned on.

Make sure that no lights are indicating errors.

Access the EPSON Printer Utility3.

Accessing the Printer Driver for Mac OS X 

Click the Head Cleaning button in the Utility dialog box.

Follow the on-screen instructions.

The  power light flashes while the printer performs the cleaning cycle.

Caution:

Never turn off the printer while the  power light is flashing. Doing so may damage the printer.

Note:

●     

If print quality has not improved after repeating this procedure about four times, turn the 
printer off and wait for at least six hours. Then run the nozzle check again and repeat the 
head cleaning if necessary. If print quality has still not improved, contact Epson support.

●     

To maintain print quality, we recommend printing a few pages on a regular basis.
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Using the Printer Buttons

Follow the steps below to clean the print head using the printer buttons.

Make sure that no lights are indicating errors.

Make sure that Letter- or A4-size paper is loaded in the sheet feeder.

Press and hold down the  maintenance button for three seconds.

The printer starts cleaning the print head and the  power light begins flashing.

Caution:

Never turn off the printer while the  power light is flashing. Doing so may damage the printer.

When the  power light stops flashing, print a nozzle check pattern to confirm that the head is clean.

Checking the Print Head Nozzles 

Note:

●     

If print quality has not improved after repeating this procedure about four times, turn the 
printer off and wait for at least six hours. Then run the nozzle check again and repeat the 
head cleaning if necessary. If print quality has still not improved, contact Epson customer 
support. 

 See Contacting Technical Support

●     

To maintain print quality, we recommend printing a few pages on a regular basis.
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Aligning the Print Head

Using the Print Head Alignment Utility for Windows 

Using the Print Head Alignment Utility for Mac OS X 

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this problem by using the 
Print Head Alignment utility in your printer driver.

Refer to the appropriate section below.

Note:

Do not press the  maintenance button to cancel printing while printing a test pattern with the Print 
Head Alignment utility.

Using the Print Head Alignment Utility for Windows

Follow the steps below to align the print head using the Print Head Alignment utility.

Make sure that no lights are indicating errors.

Make sure Letter- or A4-size paper is loaded in the sheet feeder.

Right-click the printer icon on the taskbar, then select Print Head Alignment.

If the printer icon does not appear, refer to the following section to add the icon.

From the Shortcut Icon on the Taskbar 

Follow the on-screen instructions to align the print head.
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Using the Print Head Alignment Utility for Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.

Make sure that no lights are indicating errors.

Make sure Letter- or A4-size paper is loaded in the sheet feeder.

Access the EPSON Printer Utility3 dialog box.

Accessing the Printer Driver for Mac OS X 



Click the Print Head Alignment button in the Utility dialog box.

Follow the on-screen instructions to align the print head.
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Cleaning the Paper Guide

Using the Paper Guide Cleaning Utility for Windows 

Using the Paper Guide Cleaning Utility for Mac OS X 

You may see a smudge on the back of the printout when excessive ink remains on the paper guide. The paper guide is 
the dark plastic strip inside the printer. In this case, you can solve the problem by using the Paper Guide Cleaning utility 
in your printer driver.

Refer to the appropriate section below.

Note:

Repeat the procedure until the inside of the printer is cleaned.

Using the Paper Guide Cleaning Utility for Windows

Follow the steps below to clean the paper guide using the Paper Guide Cleaning utility.

Make sure that no lights are indicating errors.

Make sure Letter- or A4-size paper is loaded in the sheet feeder.

Open the printer driver, click the Maintenance tab, then click the Paper Guide Cleaning button.

Accessing the Printer Driver for Windows 

Follow the on-screen instructions to clean the paper guide.
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Using the Paper Guide Cleaning utility for Mac OS X

Follow the steps below to clean the paper guide using the Paper Guide Cleaning utility.

Make sure that no lights are indicating errors.

Make sure Letter- or A4-size paper is loaded in the sheet feeder.

Access the EPSON Printer Utility3 dialog box.

Accessing the Printer Driver for Mac OS X 



Click the Paper Guide Cleaning button in the Utility dialog box.

Follow the on-screen instructions to clean the paper guide.
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Cleaning Your Printer

Cleaning the Exterior of the Printer 

Cleaning the Interior of the Printer 

Cleaning the Exterior of the Printer

To keep your printer operating at its best, clean it thoroughly several times a year by using the following 
instructions.

Caution:

Never use alcohol or thinner to clean the printer. These chemicals can damage the printer.
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Cleaning the Interior of the Printer

To keep your printouts at their best, clean the roller inside by using the Paper Guide Cleaning utility.

Cleaning the Paper Guide 
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Transporting Your Printer

If you need to transport your printer some distance, carefully prepare and repack it as described below. Use the 
original box and packing materials, or a similar box that holds the printer snugly.

Caution:

●     

When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it 
upside down; otherwise ink may leak from the cartridges.

●     

Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head 
and may prevent the printer from printing.

Plug in the printer and turn it on. Wait until the ink cartridge holder returns to the home position, then close the 
printer cover.

Turn off the printer and unplug its power cord.

Disconnect the USB cable.

Remove all paper from the sheet feeder.

Open the printer cover. Secure the ink cartridge holder with tape, as shown below, then close the printer cover.

Remove the output tray and paper support.



Attach the protective materials to both sides of the printer.

Repack the printer and power cord in the original box.

Note:

●     

Keep the printer level during transport.

●     

Be sure to remove the protective materials and tape from the printer before using it again.
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Setup for Windows

Setting up the Printer as a Shared Printer 

Adding the Printer to the Other Network Computers 

These instructions tell you how to set up your printer so other users on the network can share it.

First you will set up the printer as a shared printer on the computer directly connected to it. Then you will add the printer 
to each network computer that will access it.

Note:

●     

These instructions are for small networks only. To share the printer on a large network, 
consult your network administrator.

●     

To uninstall programs in Windows Vista, you need an administrator account and the password 
if you log on as a standard user.

●     

You must log on to a Computer Administrator account to install software on Windows XP. After 
you install Windows XP, the user account is set as Computer Administrator.

●     

You must log on to Windows 2000 as a user with administrative privileges (belonging to the 
Administrators group) to install software.

●     

The illustrations in the following section are from Windows Vista.

Setting Up the Printer as a Shared Printer

Follow the steps below on the computer that is connected directly to the printer:

Windows Vista:  

Click the  button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP:  
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other 
Hardware category.

Windows 2000:  
Click Start, point to Settings, and click Printers.

Right-click the icon for your printer, then click Sharing. For Windows Vista, click the Change sharing options 
button and then click Continue.



Windows Vista and XP:  
Select Share this printer, then type a Share name.

Windows 2000:  
Select Shared as, then type a name for the shared printer.

Note:

Do not use spaces or hyphens in the share name.

If you want Windows Vista, Windows XP, and Windows 2000 to automatically download printer drivers for 
computers that are running different versions of Windows, click Additional Drivers and select the environment 
and the operating systems of the other computers. Click OK, then insert the printer software CD into the CD-ROM 
drive.

Click OK or Close (if you installed additional drivers).
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Adding the printer to the other network computers

Follow these steps to add the printer to each network computer that will access it.



Note:

Your printer must be set up as a shared printer on the computer to which it is connected before you can 
access it from another computer. 

 See Setting up the Printer as a Shared Printer 

Windows Vista:  

Click the  button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP:  
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other 
Hardware category.

Windows 2000:  
Click Start, point to Settings, and click Printers.

Windows Vista:  
Click the Add a Printer button.

Windows XP and 2000:  
Double-click the Add Printer icon. The Add Printer Wizard appears. Click the Next button.

Windows Vista:  
Click Add a network, wireless or Bluetooth printer, and then click Next.

Windows XP:  
Select A network printer, or a printer attached to another computer, then click Next.

Windows 2000:  
Select Network printer, then click Next.



Follow the on-screen instructions to select the printer you want to use.

Note:

Depending on the operating system and the configuration of the computer to which the printer is 
connected, the Add Printer Wizard may prompt you to install the printer driver from the printer software 
CD-ROM. Click the Have Disk button and follow the on-screen instructions.
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Setup for Mac OS X

To set up your printer on a Mac OS X network, use the Printer Sharing setting. See your Macintosh 
documentation for details.

Note:

When your printer is shared on a Mac OS X network, the  EPSON Printer Utility3 icon 
does not appear in the Print window.

Note for Mac OS X 10.5.x:

When your printer is shared on a Mac OS X network, the Low Ink Reminder screen does 
not appear.
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Diagnosing the Problem

Error Indicators 

EPSON Status Monitor 3 (Windows Only) 

Running a Printer Operation Check 

Troubleshooting printer problems is best handled in two steps: first diagnose the problem, then apply likely solutions 
until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by online problem solving, the 
control panel, the Status Monitor utility, or by running a printer operation check. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printout problem not related to print quality, or a paper feeding 
problem, or if the printer does not print at all, refer to the appropriate section.

To solve a problem, you may need to cancel printing.

Canceling Printing 

Error Indicators

You can identify many common printer problems using the lights on your printer. If the printer stops working and the 
lights are on or flashing, use the following table to diagnose the problem, then follow the recommended corrective 
measures.

Lights Problem and solution

Paper out

No paper is loaded. Load paper into the sheet feeder, and then 
press the  maintenance button. The 
printer resumes printing and the light goes 
out.

Paper jam

Paper has jammed in the printer.
 See The Paper Jams 

Ink expended

An ink cartridge is expended or not installed. Replace the ink cartridge with a new one. If 
the light is still on after you have replaced 
the cartridge, it may not be installed 
correctly. Reinstall the ink cartridge so that it 
clicks into place. 

 See Replacing an Expended Ink Cartridge 

Wrong cartridge

The currently installed ink cartridge cannot 
be used with the printer.

Replace the incompatible cartridge with an 
appropriate ink cartridge. 

 See Replacing an Ink Cartridge Before It 
Is Expended 



Incorrectly installed ink cartridge

An ink cartridge is not installed correctly. Reinsert the ink cartridge. 

 See The ink light is flashing or is on after 
you replace the cartridge 

Multiple feed error

During 2-sided printing, the printer feeds 
more than one sheet of paper at a time.

Load paper in the sheet feeder and press the 
 maintenance button to resume printing.

Ink low

An ink cartridge is nearly expended. Obtain a replacement ink cartridge. To 
determine which cartridge is nearly 
expended, check the ink cartridge status. 

 See Checking the Ink Cartridge Status 

Cartridge holder in the wrong position

The print head is obstructed by jammed 
paper or other foreign material and cannot 
return to the home position.

Turn off the printer. Open the printer cover 
and remove any paper or other obstructions 
from the paper path. Then turn the printer 
back on. If the error does not clear, contact 
Epson customer support. 

 See Contacting Technical Support

Flashing 
alternately

Maintenance

The printer’s ink pads are at the end of their 
service life.

Contact Epson support to replace ink pads. 

 See Contacting Technical Support

 : on,  : off,  : flashing
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EPSON Status Monitor 3 (Windows Only)

If a problem occurs while printing, an error message will appear in the Status Monitor window.

When you need to replace an ink cartridge, click the How To button on the window, and EPSON Status Monitor 3 will 
lead you step-by-step through the cartridge replacement procedure.

If an error message appears indicating the printer’s ink pads are nearing the end of their service life, contact Epson 
support to replace them. When the printer’s ink pads are saturated, the printer stops and Epson support is required to 
continue printing.
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Running a Printer Operation Check

If you are unable to determine the source of the problem, run a printer operation check to help you determine whether 
the problem comes from the printer or your computer.

To run a printer operation check, follow these steps.

Make sure both the printer and computer are turned off.



Disconnect the USB cable.

Make sure that Letter- or A4- size paper is loaded in the sheet feeder.

Hold down the  maintenance button and press the  power button to turn on the printer. When the printer 
turns on, release both the buttons. 

A test page prints showing a nozzle check pattern. If the pattern has gaps, you need to clean the print head.

Cleaning the Print Head 

If the test page prints, the problem probably lies in your software settings, the cable, or your computer. It is 
also possible that your software may not be installed correctly. Try uninstalling your software and reinstalling it. 

 See Uninstalling the Printer Software 

If the test page does not print, you may have a problem with your printer. Try the suggestions in the following 
section. 

 See The printer does not print 
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Checking Printer Status

For Windows 

For Mac OS X 

For Windows

Using the progress meter

When you send a print job to the printer, the progress meter appears, as shown in the illustration below.

The progress meter indicates the progress of the current print job and provides printer status information. This window 
also displays error messages as well as helpful tips for better printing. Refer to the appropriate section below.

Tips

Various tips for getting the most out of your Epson printer driver appear in the text box of the progress meter window. 
For more details on the tip displayed in the window, click the Details button.



Error messages

If a problem occurs during printing, an error message appears in the text box of the progress meter window. For more 
detailed information, click Online Support to access the online User’s Guide.

When the ink is low or expended, a How to button appears. Click How to, and EPSON Status Monitor 3 will lead you 
step-by-step through the cartridge replacement procedure.

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the printer status.

There are two ways to access EPSON Status Monitor 3:

Double-click the printer shortcut icon on the Windows taskbar. 

 See From the Shortcut Icon on the Taskbar to add short cut icon on the Windows taskbar.

Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button.



When you access EPSON Status Monitor 3, the following window appears:

EPSON Status Monitor 3 provides the following information:

Current Status:  
If the ink is low or expended, the How to button appears in the EPSON Status Monitor 3 window. Clicking How 
to displays ink cartridge replacement instructions and moves the print head to the ink cartridge replacement 
position.
Ink Levels:  
EPSON Status Monitor 3 provides a graphic display of the ink cartridge status.
Information:  
You can view information about the installed ink cartridges by clicking Information.
Online Support:  
You can access Epson's global website from EPSON Status Monitor 3. If you encounter a problem, click Online 
Support in the EPSON Status Monitor 3 window then select your country and go to the Technical Support 
section of your country's website.
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For Mac OS X

Using EPSON StatusMonitor

If EPSON StatusMonitor detects a printer problem, it will inform you with an error message.



Follow these steps to access EPSON StatusMonitor.

Access the EPSON Printer Utility3.

Accessing the Printer Driver for Mac OS X 

Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

When ink is low or expended, a How to button appears. Click How to, and EPSON StatusMonitor will lead you step by 
step through the ink cartridge replacement procedure.



You can also use this utility to check the ink cartridge status before printing. EPSON StatusMonitor displays the ink 
cartridge status at the time it was opened. To update the ink cartridge status, click Update.
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Print Quality Problems

Horizontal Banding 

Vertical Misalignment or Banding 

Incorrect or Missing Colors 

Blurry or Smeared Printout 

If you are having print quality problems, then compare it with the illustrations below. Click the caption under the 
illustration that best resembles your printout.

Good sample Good sample

Horizontal banding Vertical misalignment or banding 

Horizontal banding Vertical misalignment or banding 

Incorrect or missing colors Blurry or smeared printout 

Horizontal Banding

●     



Make sure the printable side of the paper is face up in the sheet feeder.

●     

Run the Head Cleaning utility to clear any clogged ink nozzles. 

 See Cleaning the Print Head 

●     

Use up ink cartridge within six months of opening vacuum package.

●     

Use genuine Epson ink cartridges.

●     

Check the  error light. If the light is flashing, replace the appropriate ink cartridge. 

 See Replacing an Ink Cartridge Before it Is Expended 

●     

Make sure the paper type selected in the printer driver is appropriate for the type of paper loaded in the 
printer. 

 See Selecting the Correct Paper Type 
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Vertical Misalignment or Banding

●     

Make sure the printable side of the paper is face up in the sheet feeder.

●     

Run the Head Cleaning utility to clear any clogged ink nozzles. 

 See Cleaning the Print Head 

●     

Run the Print Head Alignment utility. 

 See Aligning the Print Head 

●     

Clear the High Speed check box from the Advanced window in your printer driver (Windows). See the online 
help for details.

●     

Make sure the paper type selected in the printer driver is appropriate for the type of paper loaded in the 
printer. 

 See Selecting the Correct Paper Type 
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Incorrect or missing colors

●     

For Windows, clear Grayscale from Print Options in the Main window in your printer driver. 
For Mac OS X, change the Color setting to Color in Print Settings in the Print dialog box in your printer driver. 
See the printer driver online help for details.



Adjust the color settings in your application or in your printer driver settings. 
For Windows, check the Advanced window. 
For Mac OS X, check the Print Settings dialog box from the Print dialog box. 
See the printer driver online help for details.

●     

Run the Head Cleaning utility. 

 See Cleaning the Print Head 

●     

Check the  error light. If the light is flashing, replace the appropriate ink cartridge. 

 See Replacing an Ink Cartridge Before it is Expended 

●     

If you have just replaced an ink cartridge, make sure the date on the box has not expired. 

●     

If you have not used the printer for a long time, replace the ink cartridges. 

 See Replacing an Ink Cartridge Before it is Expended 
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Blurry or smeared printout

●     

Use only paper recommended by Epson. 

 See Paper 

●     

Try to use genuine Epson ink cartridges.

●     

Make sure the printer is on a flat, stable surface that extends beyond the base in all directions. The printer 
will not operate properly if it is tilted.

●     

Make sure your paper is not damaged, dirty, or too old.

●     

Make sure your paper is dry and the printable side is facing up.

●     

Make sure your paper is dry and the printable side is face down in the paper cassette.

●     

If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

●     

Make sure the paper type selected in the printer driver is appropriate for the type of paper loaded in the 
printer. 

 See Selecting the Correct Paper Type 

●     

Remove each sheet from the output tray as it is printed.

●     

If you are printing on glossy media, place a support sheet (or a sheet of plain paper) beneath the stack, or 
load only one sheet at a time.



Do not touch or allow anything to come into contact with the printed side of paper with a shiny finish. To 
handle your printouts, follow the instructions of the paper.

●     

Run the Head Cleaning utility. 

 See Cleaning the Print Head 
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Miscellaneous Printout Problems

Incorrect or Garbled Characters 

Incorrect Margins 

Printout Has a Slight Slant 

Inverted Image 

Blank Pages Print 

Printed Side is Smeared or Scuffed 

Printing Is Too Slow 

Incorrect or Garbled Characters

●     

Clear any stalled print jobs from the Windows Spooler (Windows only). 

 See Canceling Printing 

●     

Turn off the printer and computer. Make sure the printer’s USB cable is securely plugged in.

●     

Uninstall the printer driver, then reinstall it. 

 See Uninstalling the Printer Software 
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Incorrect Margins

●     

Check the margin settings in your application. Make sure that the margins are within the 
printable area of the page. 

 See Printable area 

●     

Make sure the printer driver settings are appropriate for the paper size you are using. 
For Windows, check the Main window. 
For Mac OS X, check the Page Setup dialog box or Print dialog box. 
See the printer driver online help for details.

●     

Uninstall the printer driver, then reinstall it. 

 See Uninstalling the Printer Software 
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Printout Has a Slight Slant

If Fast Economy is selected in Paper & Quality Options in the Advanced window in your printer 
driver (for Windows), or in Print Quality which is available when you select Advanced mode in 
Print Settings (for Mac OS X), change it to Economy.  
(Fast Economy is only available when the paper type is Plain paper/Bright White Paper.)
Make sure that the paper is loaded into the sheet feeder correctly. 

 See Loading Paper 
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Inverted Image

●     

For Windows, clear the Mirror Image check box from the Page Layout window of your printer 
driver, or turn off the Mirror Image setting in your application. 
For Mac OS X, clear the Mirror Image check box in Print Settings in the Print dialog box of 
your printer driver, or turn off the Mirror Image setting in your application. 
For instructions, see the online help for your printer driver or for your application.

●     

Uninstall the printer driver, then reinstall it. 

 See Uninstalling the Printer Software 
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Blank Pages Print

●     

Make sure the printer driver settings are appropriate for the paper size you are using. 
For Windows, check the Main window. 
For Mac OS X, check the Page Setup dialog box or Print dialog box. 
See the printer driver online help for details.

●     

For Windows, check the Skip Blank Page setting by clicking the Speed & Progress button on 
the Maintenance window of the printer driver. 
For Mac OS X, check the Skip Blank Page setting in Extension Settings in the Print dialog box of 
your printer driver. If it is selected, blank pages in your data are not printed.

●     

Uninstall the printer driver, then reinstall it. 

 See Uninstalling the Printer Software 

After trying one or more of these solutions, run a printer operation check to check your results.

Running a printer operation check 
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Printed Side Is Smeared or Scuffed

●     

If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite 
direction.

●     

Clear the High Speed check box in the settings from your printer driver. 
For Windows, check the Advanced window. 
For Mac OS X, check the Print Settings dialog box from the Print dialog box. 
See the printer driver online help for details.

●     

Load and eject plain paper several times. 

 See Cleaning Your Printer 

●     

Uninstall the printer driver, then reinstall it. 

 See Uninstalling the Printer Software 
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Printing is Too Slow

Make sure the paper type selected in the printer driver is appropriate for the type of paper loaded in 
the printer. 

 See Selecting the Correct Paper Type 

For Windows, clear all customized settings and select Text as the Quality Option from your printer 
driver’s Main window. 

 See Accessing the printer driver for Windows.  
For Mac OS X, clear all customized settings and select Automatic as the Mode and move the slider 
to Speed in the Print Settings dialog box from your printer driver’s Print dialog box. See the printer 
driver online help for details. 

 See Accessing the printer driver for Mac OS X 

Close any unnecessary applications.
If you print continuously for an extended period, the paper may temporarily stop feeding or the print 
head may pause for a while. This is to slow down the printing speed and prevent the printer 
mechanism from overheating and being damaged. If this happens, you can continue to print, but we 
recommend stopping and leaving the printer for about thirty minutes with the power on. (The printer 
does not recover with the power off.) After you restart, the printer will print at normal speed.
Uninstall the printer driver, then reinstall it. 

 See Uninstalling the Printer Software 

If you try all of the methods above and cannot solve the problem, see the following:

Increasing the Print Speed (Windows only) 
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Paper Does Not Feed Correctly

Paper Does not Feed 

Multiple Pages Feed 

The Paper Jams 

Paper Is Improperly Loaded 

Paper Is not Ejected fully or Is Wrinkled 

Paper Does not Feed

Remove the stack of paper and make sure of the following:

●     

The paper is not curled or creased. 

●     

The paper is not too old. See the instructions that came with the paper for more information. 

●     

The paper fits under the  arrow mark inside the edge guide. 

●     

The number of sheets in the paper stack does not exceed the limit specified for the media. 

 See Loading Capacities for Epson Special Media 

●     

Paper is not jammed inside the printer. If it is, remove the jammed paper. 

 See The Paper Jams 

●     

The ink cartridges are not expended. If a cartridge is expended, replace it. 

 See Replacing an Expended Ink Cartridge 

●     

You have followed any special loading instructions that came with your paper. Load the paper again. 

 See Loading Paper 

●     

The paper does not have any binder holes.
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Multiple Pages Feed

●     

Make sure the paper stack fits under the  arrow mark inside the edge guide.

●     

Make sure the edge guide is snug against the left edge of the paper.

●     

Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the opposite 
side before loading.

●     

Remove the stack of paper and make sure that the paper is not too thin. 

 See Paper 

●     

Fan the edges of the stack to separate the sheets, then reload the paper.

●     

If too many copies of a file are being printed, check the Copies setting in your printer driver as 
follows, and also check in your application. 
For Windows, check the Copies setting on the Page Layout window. 
For Mac OS X 10.3.9 and 10.4.x, check the Copies setting in the Copies & Pages setting in the Print 
dialog box. 
For Mac OS X 10.5.x, check the Copies setting in the Print dialog box. 
See the printer driver online help for details.
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The Paper Jams

If the paper is stuck inside the printer, open the printer cover, then remove all of the paper inside, including 
any torn pieces. Close the printer cover. If paper remains near the sheet feeder, gently pull it out. Then 
carefully reload paper and press the  maintenance button to resume printing.

Note:

If you cannot easily remove a foreign object, do not use force and do not disassemble the 
printer. Call Epson customer support. 

 See Contacting Technical Support

If your paper jams frequently, make sure of the following:

●     

The paper is smooth, not curled or wrinkled. 

●     

You are using high quality paper. 

●     

The printable side of the paper is face up in the sheet feeder. 

●     

The paper stack was fanned before loading. 



●     

The paper is not loaded above the  arrow mark inside the edge guide. 

●     

The number of sheets in the paper stack does not exceed the limit specified for that paper. 

 See Loading Capacities for Epson Special Media 

●     

The edge guide is snug against the left edge of the paper. 

●     

The printer is on a flat, stable surface that extends beyond the base in all directions. The printer will not 
operate properly if it is tilted.
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Paper Is Improperly Loaded

If you have loaded the paper too far into the printer, the printer cannot feed the paper correctly. Turn the 
printer off and gently remove the paper. Then turn the printer on and reload the paper correctly.
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Paper is not ejected fully or is wrinkled

●     

If the paper does not eject fully, press the  maintenance button, then open the printer cover 
and remove the paper. Also, check the Paper Size setting in your application or printer settings. 
See the online help for details.

●     

If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack of paper.

Note:

Store any unused paper in its original packaging in a dry area.
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The Printer Does Not Print

All lights Are Off 

Lights Came On and then Went Out 

Only the Power Light Is On 

The Ink Light Is Flashing or Is On After You Replace the Cartridge 

All Lights Are Off

●     

Press the  power button to make sure the printer is on.

●     

Turn off the printer and make sure that the power cord is securely plugged in.

●     

Make sure that your outlet works and is not controlled by a wall switch or timer.
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Lights Came On and then Went Out

The printer’s voltage may not match the outlet rating. Turn off the printer and unplug it immediately. Then check the label 
on the back of the printer.

Caution:

If the voltage does not match, DO NOT PLUG YOUR PRINTER BACK IN. Contact Epson customer support. 

 See Contacting Technical Support
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Only The Power Light Is On

●     

Turn off the printer and the computer. Make sure the printer’s USB cable is securely plugged in.

●     

If you are using the USB interface, make sure your cable meets the USB 1.1 or 2.0 standards.

●     



If you are connecting the printer to your computer via a USB hub, connect the printer to the first-tier hub from 
your computer. If the printer driver is still not recognized on your computer, try to directly connect the printer 
to your computer without the USB hub. 

●     

If you are connecting the printer to your computer via a USB hub, make sure the USB hub device is recognized 
by your computer. 

●     

Turn off the printer and the computer, disconnect the printer’s interface cable, then print an operation check 
page. 

 See Running a Printer Operation Check 

●     

If the check page prints correctly, make sure the printer driver and your application are installed correctly.

●     

If you are trying to print a large image, your computer may not have enough memory. Try reducing the 
resolution of your image or printing the image at a smaller size. You may need to install more memory in your 
computer.

●     

Users of Windows can clear any stalled print jobs from the Windows Spooler. 

 See Canceling Printing 

●     

Uninstall the printer driver, then reinstall it. 

 See Uninstalling the Printer Software 
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The Ink Light Is Flashing or Us On After You Replace the Cartridge

Make sure the print head is at the ink cartridge replacement position.

Note:

If the print head is at the far right position, press the  maintenance button to move it to the ink 
cartridge replacement position.

Remove and reinsert the ink cartridge and then continue with the ink cartridge installation.

N



Close the ink cartridge cover firmly.
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Increasing the Print Speed (Windows Only)

You can increase print speed by selecting certain settings in the Speed & Progress window. Click the Speed & Progress 
button on your printer driver’s Maintenance window.

The following dialog box appears.



The table below lists the factors affecting print speed.

Print speed Faster Slower

High Speed Copies On Off

Always spool RAW datatype On Off

Page Rendering Mode On Off

Print as Bitmap On Off

For more details on each item, see the online help.
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Technical Support Web Site

Epson’s Technical Support Web Site provides help with problems that cannot be solved using the 
troubleshooting information in your product documentation. If you have a Web browser and can connect 
to the Internet, access the site at:

http://www.latin.epson.com 

http://www.latin.epson.com/
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Contacting Customer Support

Before You Contact Epson 

Telephone Support for Users in Latin America 

Before You Contact Epson

If your Epson product is not operating properly and you cannot solve the problem using the 
troubleshooting information in your product documentation, contact Epson's customer support services for 
assistance. If customer support for your area is not listed below, contact the nearest Epson sales office for 
referral information.

Customer support will be able to help you much more quickly if you give them the following information:

●     

Product serial number 
(The serial number label is usually on the back of the product.) 

●     

Product model 

●     

Product software version 
(Click About, Version Info, or similar button in the product software.) 

●     

Brand and model of your computer 

●     

Your computer operating system name and version 

●     

Names and versions of the software applications you normally use with your product
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Telephone Support for Users in Latin America

Argentina (54 11) 5167-0300

Brazil (55 11) 3956-6868

Chile (56 2) 230-9500

Colombia (57 1) 523-5000

Costa Rica (50 6) 210-9555 
(800) 377-6627



Mexico 
Mexico City: 
Other cities:

 
(52 55) 1323-2052 
01-800-087-1080

Peru (51 1) 418-0210

Venezuela (58 212) 240-1111
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Printer Parts and Control Panel Functions

Printer Parts 

Control Panel 

Printer Parts

a. Paper support: Supports the paper loaded in the sheet feeder.

b. Sheet feeder: Holds your paper and feeds it for printing.

c. Printer cover: Covers the printing mechanism. Open only when installing or replacing ink cartridges.

d. Output tray: Holds the ejected paper.

e. Edge guide: Holds your paper straight in the sheet feeder. Move the edge guide to the edge of your 
paper.



f. USB port: Connects the USB cable from your computer to the printer.

a. Cartridge cover: Secures the ink cartridges. Open only when installing or replacing ink cartridges.

b. Ink cartridge holder: Holds the ink cartridges.

c. Print head: Prints ink on your paper.

d. Control panel: Use the buttons and monitor the lights to control your printer. See the next section for 
details.
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Control Panel

Buttons

Button Function



power

Press to turn the printer on and off.

maintenance

Press to load paper when the printer is out of paper. Press to eject paper when paper 
is jammed.
Press to resume printing after a paper out error or multiple page feed error.
Press to cancel printing during a print job.

Press to move the ink cartridge holder to the ink cartridge replacement position when 
an ink cartridge needs to be replaced.
When an expended ink cartridge is detected, press to move the ink cartridge holder 
to the ink check position.
After ink cartridge replacement, press to return the ink cartridge holder to its home 
position.

When the  error light is off, press and hold for 3 seconds to clean the print head.

Lights

Light Description

power

On when the printer is on.
Flashes when the printer is receiving data, printing, replacing an ink cartridge, 
charging ink, or cleaning the print head.

error

On when the printer is out of paper or paper is jammed.

On when an ink cartridge is expended.
Flashes when an ink cartridge is nearly expended.

For details on the error status, see the following instructions. 

 See Error Indicators 
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Ink and Paper

Ink Cartridges 

Paper 

Ink cartridges

You can use the following ink cartridges with this printer:

Ink cartridge color Part numbers for  
Epson Stylus T21

Black 90N 
73N 

Cyan 73N

Magenta 73N

Yellow 73N
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Paper

Epson offers specially-designed paper and other print media for all your printing needs.

Note:

You can find the part numbers for the following Epson special papers on the Epson support Web 
site. 

 See Technical Support Web Site 

Paper Size

Epson Bright White Paper Letter (8,5 × 11 in. [21.59 × 
27.94 cm])

Epson Premium Photo Paper Glossy Letter (8,5 × 11 in. [21.59 × 
27.94 cm])

4 × 6 in. (10 × 15 cm)

5 × 7 in. (13 × 18 cm)

16:9 wide size (102 × 181 mm)



Epson Premium Photo Paper Semi-gloss Letter (8,5 × 11 in. [21.59 × 
27.94 cm])

4 × 6 in. (10 × 15 cm)

Epson Ultra Premium Photo Paper Glossy Letter (8,5 × 11 in. [21.59 × 
27.94 cm])

4 × 6 in. (10 × 15 cm)

5 × 7 in. (13 × 18 cm)

Epson Photo Paper Glossy Letter (8,5 × 11 in. [21.59 × 
27.94 cm])

4 × 6 in. (10 × 15 cm)

Epson Premium Presentation Paper Matte A4 (210 × 297 mm [8.3 × 11.7 
in.]) 
Letter (8,5 × 11 in. [21.59 × 
27.94 cm])

Epson High Quality Ink Jet Paper A4 (210 × 297 mm; 8.3 × 11.7 in)

Note:

The availability of paper varies by location.
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System Requirements

Windows System Requirements 

Macintosh System Requirements 

Windows System Requirements

To use this printer, your system should include:

●     

A Microsoft Windows compatible PC with an 800 MHz or faster processor 

●     

Microsoft Windows 2000, XP, XP Professional x64, or Windows Vista

●     

256MB RAM for Windows 2000, Windows XP, and Windows XP Professional Edition (512MB 
recommended) 
512MB RAM for Windows Vista (1GB recommended)

●     

300MB free hard disk space (550MB recommended)

●     

4× or faster CD-ROM drive for installing the software

●     

A Windows-compliant UBS port and shielded USB "AB" cable up to 2 m long. Using an improperly 
shielded USB cable may cause the printer to malfunction

 

Macintosh System Requirements

To use this printer, your system should include:

●     

An Apple Macintosh with a PowerPC or Intel processor

●     

Mac OS X 10.3.9, 10.4.x - 10.5.x

●     

256MB RAM (512MB recommended)



●     

300MB free hard disk space (550MB reommended)

●     

4× or faster CD-ROM drive for installing the software 

●     

A Macintosh-compliant UBS port and shielded USB "AB" cable up to 2 m long. Using an improperly 
shielded USB cable may cause the printer to malfunction

Top  
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Technical Specifications

Paper 

Ink Cartridges 

Mechanical 

Electrical 

Environmental 

Standards and Approvals 

Interface 

Paper

Note:

Since the quality of any particular brand or type of paper may be changed by the manufacturer at 
any time, Epson cannot attest to the quality of any non-Epson brand or type of paper. Always test 
samples of paper stock before purchasing large quantities or printing large jobs.
Poor quality paper may reduce print quality and cause paper jams or other problems. If you 
encounter problems, switch to a higher grade of paper.
Use paper under normal conditions: 
Temperature 15 to 25 •C (59 to 77 •F)  
Humidity 40 to 60% RH 

Single sheets: 

Size A4 (210 × 297 mm)
4 × 6 in. (10.2 × 15.2 cm)
5 × 7 in. (12.7 × 17.8 cm)
A6 (105 × 148 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)
3.5 × 5 in. (8.9 × 12.7 cm)
13 × 20 cm 
8 × 10 in. (20.3 × 25.4 cm)
16:9 wide size (102 × 181 mm)
Letter 8 1/2 × 11 in. (21.6 × 27.9 cm)
Legal 8 1/2 × 14 in. (21.6 × 35.6 cm)

Paper types Plain paper or special paper distributed by Epson

Thickness 
(for plain paper) 

0.08 to 0.11 mm (0.003 to 0.004 in.)

Weight  
(for plain paper) 

64 g/m² (17 lb) to 90 g/m² (24 lb)

Envelopes: 



Size Envelope #10 4 1/8 × 9 1/2 in.
Envelope DL 110 × 220 mm
Envelope C6 114 × 162 mm

Paper types Plain paper

Weight 75 g/m² (20 lb) to 90 g/m² (24 lb)

Printable Area

Highlighted portions show printable area.

Single sheets: 

Normal Borderless

Envelopes: 

  Minimum margin

Media type Single sheets Envelopes

A 3.0 mm (0.12 in.) 3.0 mm (0.12 in.)

B 3.0 mm (0.12 in.) 5.0 mm (0.20 in.)

C 3.0 mm (0.12 in.) 20 mm (0.78 in.)



Note:

Depending on the type of paper, print quality may decline in the top and bottom areas of the printout, or 
the area may be smeared.
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Ink Cartridges

Color Yellow (73N), Magenta (73N), Cyan (73N), Black (90N or 73N)

Cartridge life Use within 6 months of opening the package.

Temperature Storage: 
-20 to 40 •C (-4 to 104 •F) 
1 month at 40 •C (104 •F)
Freezing:* 
-16 •C (3.2 •F)

* Ink thaws and is usable after approximately 3 hours at 25 •C (77 •F).

Caution:

Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality 
or reliabity of non-genuine ink. The use of non-genuine ink may cause damage that is not covered 
by Epson's warranties, and under certain circumstances, may cause erratic printer behavior. 
Information about non-genuine ink levels may not be displayed..
Use the ink cartridge before the date printed on its package.

Note:

The ink cartridges packaged with your printer are partly used during initial setup. In order to 
produce high quality printouts, the print head in your printer will be fully charged with ink. This 
one-off process consumes a quantity of ink and therefore these cartridges may print fewer pages 
compared to subsequent ink cartridges.
Quoted yields may vary depending on the images that you are printing, the paper type that you 
are using, the frequency of your prints and environmental conditions such as temperature.
To ensure you receive premium print quality and to help protect your print head, a variable ink 
safety reserve remains in the cartridge when your printer indicates to replace the cartridge. The 
yields quoted for you do not include this reserve.
Although the ink cartridges may contain recycled materials, this does not effect product function 
or performance.
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Mechanical

Paper path Sheet feeder, top entry

Sheet feeder capacity About 80 sheets at 90 g/m² (24 lb) paper*



Dimensions Storage
Width: 435 mm (17.3 inches)
Depth: 219 mm (8.6 inches)
Height: 165 mm (6.5 inches)

Printing
Width: 435 mm (17.3 inches)
Depth: 418 mm (16.5 inches)
Height: 289 mm (11.4 inches)

Weight Approx. 2.8 kg (6.16 lb) without the ink cartridges

* For Legal and User Defined sizes, load one sheet at a time.
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Electrical

  100-120 V Model 220-240 V Model

Input voltage range 90 to 132 V 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4 A 0.2 A

Power consumption Printing Approx. 11 W (ISO/
IEC24712)

Approx. 11 W (ISO/
IEC24712)

Ready mode Approx. 3.0 W Approx. 3.5 W

Sleep mode Approx. 2.5 W Approx. 3.0 W

Power off Approx. 0.2 W Approx. 0.4 W

Note:

Check the label on the back of the printer for its voltage.
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Environmental

Temperature Operation: 
10 to 35 •C (50 to 95 •F)
Storage:  
-20 to 40 •C (-4 to 104 •F)
1 month at 40 •C (104 •F)

Humidity Operation:*  
20 to 80% RH
Storage:* 5 to 85% RH

* Without condensation
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Standards and approvals

European model:

Low voltage directive 2006/95/EC EN60950-1

EMC directive 2004/108/EC EN55022 Class B  
EN61000-3-2  
EN61000-3-3 
EN55024
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Interface

USB 1.1 (Device Class for computers)
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